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 ��	���
����� Block, Attribute  

&'(��	���
�)
*�+,-.��/�0��� (External references) 
 
 

 Block, Attribute &'(��	���
�)
*�+,-.��/�0��� (External reference) 9:;�9�	���
���<��=	��
.�>��	*�+,-
� Drawing &'(<��=	��9?)��@����'	�0'(9��0>'
�:
�*�+,-����0��
� Drawing <��=	�� Block 9	�
<���	,	*�='�0A *�+,-9@����9:;�*�+,-9>�0*&'(<���	,9	�0������
���>�9	���0A <��=	�� Attribute 9	�<���	,
<�
@���*��'
�:���*�+,-���9:;� Block 9��� =��09'@�)B�
��=	��	���&'(0�
<���	,���@����'��B�:���9:;�C��@����'=	��
����:*)9�	�(=D�>�>�*0 <��=	����	���
�)
/�?�	�EEF�.��/�0��� (External reference) 9	�<���	,��� 
drawing ����9@����&<>

� Drawing ���9	����'�
9:F>�0��G>0.(�����H'+��@��>@�
�E'D@�
 Drawing ��B�A 
9����
.��9:;���	����	�EEF�.���E'D Drawing ����9@����&<>
&'(,���E'D Drawing ��B�����	9:'��0�&:'
&���@ 
�	�EEF����9@����&<>
�I.(9:'��0��:+�����,��&���@�:>�*0 

�����B�J)��0,K
*)J� 

� ��	<	��
, ��	 Insert &'(��	���=�> Block 
� ��	<	��
  ��	&���@  &'(��	��	 Insert Attribute 
� ��	>K
9��@����'����0��
� Attribute �:���9:;�@����' 
� ��	&��&'(��	
��
��9���0*�����	���
�)
/�?�	�EEF�.��/�0��� 
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��� 
 ��	���
��9���0*��� Blocks  
 ��	���
��9���0*��� Attribute  
 ��	���
��9���0*�����	���
�)
/�?�	�EEF�.��/�0��� 
 

��
�����
�	 Block 
 
 G>0:�+)&'�* Block 9:;���	���*�+,-='�0�)B���:	(������9:;�*�+,-9>�0* 9	�<���	,�����	���9@��+�* 
Block 9@���:
� Drawing G>0���*�+,-���9	� Insert 9@������B�.(9:;�*�+,-�)B�9>�0*&'( Block �I.(9:;�@����'=�K�
���
�0��
� Drawing file 
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 ��	
�� Block <���	,��*09	�.�>��	*�+,-=	��9@�0��)B�
��=	��&���@&'('>@��>@�
�E'D
=���� 
Drawing 9	�<���	,<	��
*�+,-9:;�<�L'��MND9�I��*�9:;� Library G>0��	
�� Block .����B�9	�<���	,���9@��
<�L'��MND�>�<(>*��*����	���9@��.��<�L'��MND.����	9@�0�@���*�� 
 ,��9	����9@�� +�* Block ���<	��
.��*�+,-���9:;�9'90�	D 0 &'(���=�>
=�<�&'( Linetype 9:;� 
BYLAYER +�* Block ���9	����9@����*�
.(9:'��0��:+��9'90�	D&'( Linetype ������'�
9:F>�0�� &+�,��*�+,-���
��������9:;�+�* Block ,��<	��
.��9'90�	D����=	��,�����=�><�&'( Linetype �*�&'�* +�* Block ������9@�����I.(
9:;�+�����,�����=�>�*�9>)� 
 ,��9	����9@�� +�* Block ���<	��
.��*�+,-������=�>
=�<�&'( Linetype 9:;� BYBLOCK &'(9����<	��

9:;� Block &'�*���=�>9:;� BYLAYER <�&'( Linetype @�
+�* Block ���9	����9@����*�
.(9:'��0��:
+��9'90�	D������'�
9:F>�0�� &+�,��+�* Block ,�����=�><�&'( Linetype �*�&'�*9��� *�+,-�����������9:;�+�* Block 
9:;�<�&>
 9����9	����9@��+�* Block ��B�+�* Block �I.(9:;�<�&>
9���9>)� 
 
 ��	<	��
 Block  
 9�	���
���&'(���<��
<��=	��<	��
 Block &<>
��� Toolbar &'(���9��� 9����9	�+�B
G:	&�	�
=�9:;�	(>�� 
Advanced experience level 9	�<���	,
��EP
��� CAD�� Explorer �����	<	��
 block  
9	�<���	,<	��
 Block �>�<�
*)J� 

� <	��
 Block <��=	��
��/�0
� Drawing ��B�A 
� <	��
 Block &0�9�I��*�9:;��E'D&'(<���	,����:
����� Drawing �����>�>�*0 

9����9	�<	��
 Block �����		(�-����, .-> Insert point &'(9'���*�+,-���+��
��	��� Block  
  
 ��	<	��
 Block <��=	��
��/�0
� Drawing 
 
�	(>�� Advanced experience level  

1. ���+��@�B�+��+���:��B 
� 9'����:���9���  Tool > Create Block 
� 9'������ Toolbar ���	�:  
� ?)�?D block &'�*�>  Enter   

2. ?)�?D���� Block &'�*�> Enter   
3. 	(�-.-> Insert <��=	�� Block   
4. 9'���*�+,-���9	�+��
��	���9:;� Block &'�*�> Enter   

Block ����>�.(9:;� Block.���
��/�0
� Drawing ��B9�����B�&'(*�+,-���,��9'������9:;� Block .(
=�0�:9?	�(*�����,������:<	��
9:;� Block &'�* 
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5. ,��9	�+��
��	9	�0�*�+,-���,�����9:;� Block &'�*=�0�:�'�����
=�?)�?D Undelete =	�� Oops ���
�		��>���<��
 

 
NOTE: ���������	��
��
�����
�����������	��������� Block ��������� �������������� �����	 Undelete �!�����
�
��"���#� Toolbar 
 
 ��	<	��
 Block 9:;���	&0�9�I��*�9:;��E'D 
 
�	(>�� Advanced experience level 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Tools > Save Block To Disk 
� 9'������ Toolbar ���	�:   
� ?)�?D wblock &'�*�> Enter 

2. ������
@�
 File Name ?)�?D����@�
�E'D���+��
��	<	��
 
3. �')����:-Q� Save   
4. 
��		��>���<��
9'���	�0��	���+��
��	>�
+���:��B 

� Multiple Blocks ��:�����B9:;���	9	�0�9�� Block ������0��&'�*��<	��
9:;� Block ���
�		��>���&<>
 “type the name of the block(s)” ?)�?D����@�
 block ���+��
��	
9	�0���
�� 

� All Entities ��:�����B.(�����	9'���*�+,-��B
=�>������0��
� Drawing �����9:;� 
Block  

� Select Entities ��:�����B.(9:;���	9'���9R?�(*�+,-���+��
��	���9:;� Block G>0��	
�> Enter &'�*���=�>.-> Insert &'�*9'���*�+,-���+��
��	&'�*�> Enter 

 
Note: ��#���������"$��$ Insert point !�	 Wblock %��&����'����"$(����$ Insert point "�)"��*"��$ 
Coordinate 0,0,0 ������������
��"���&�"�	!�	 Coordinate (����*"���&�"�	�#�"�$�%$������+$ Wblock 
"�)"!,)"��&��
������&���!   
 
 ��	���9@�� Block 
 9	�<���	,���9@�� Block &'( Drawing ����9@����
� Drawing ������'�
9:F>�0�� 9����9	����9@�� Block .(
9=���������	<	��
*�+,-=�K�
*�+,-&'(9����9	����9@�� Drawing ��
�	�:&��@�
 Block +�* Drawing ������9@����B�
.(9:;�*�+,-�)B�9>�0*9=������� Block &'(����>�9:;���	9:F>�E'D Drawing ��B� >�
��B�9���������	&���@ Drawing 
���9	����9@������B����.(�����H'�	(����� Drawing ���9	����'�
9:F>�0��  
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9����9	����9@��  Block =	�� Drawing 9	�.(+��
	(�-+��&=��
��	*�
, <9�'&'(Rotation angle +��&=��
@�
 
Block ��������*�
.(,�����=�>+�����9	������	<	��
 Block ��B�A 9����9	����9@�� Block G:	&�	�.(���.->���
�)

��B�9:;�.->������ Block 9@���� 9	�<���	,�����	9:'��0�.->���
�)
9='����B�G>0��	���9@�� Block ��B�9@����&'(
<	��

=��G>0
��*�+,-9>)�&'�*���=�>.->���
�)

=�� 
 ��	���9@�� Block 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Insert > Block 
� 9'������ Toolbar ���	�:  
� ?)�?D  ddinsert  &'�*�> Enter   

2. 9'����:��� Block Name ��� Insert Block dialog 
3. 9'�������@�
 Block ���9	�+��
��	���9@�� 
4. �')��:���:-Q�  Insert   
5. 	(�-.->��	*�
@�
 block 
6. 	(�-<9�'&'(�-�=�-�=	���> Enter 9����0�����������=�>
=� 

 
   ��	���9@�� Block 
�'��MN(���9:;��E'D Drawing 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Insert > Block 
� 9'������ Toolbar ���	�:  
� ?)�?D  ddinsert  &'�*�> Enter   

2. 9'����:��� From File ��� Insert Block dialog 
3.  ?)�?D Path &'�*?)�?D�����E'D���+��
��	=	���')��:��� Browse &'�*9'����E'D���+��
��	���9@��&'�*
�')��:���:-Q� Open 

4.  �')��:���:-Q�  Insert   
5.  	(�-.->*�
@�
 Block 
6.  	(�-<9�'&'(�-�=�-�=	���> Enter 9����0�����������=�>
=� 
 

NOTE: ����������'����$
�	, ����&�'������"!�	 Block ���"���"���!���
���)	�����	���������	(��������
�'���$ Block ��"�
���	������"���!�� %$������� Check box ("��
"!�	 Position Block When 
inserting ��� &��
�'����
��!�
����	���("&�
!�	 Insertion Point ��*"�������"$��$
�	��#��$���
���.� 
Select ��#���'����$
�	�
��#)"�
�!�	 Drawing , ("&�
!�	 Scale Factor ��*"�������"$����("&"
&�" X, 
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Y , Z &�'("&�
!�	 Rotation Angle ��*"�������"$������"!�	
���� ������	���(���������'���$
����"���!��
��"�
���	������"���!�� �/������ Check box �
� Explode Block Upon Insertion   
 

 
 

A. 9'���<��=	����	���9@�� Block ���9:;��E'D Drawing 
B. �����	 Check box 9����+��
��		(�-.->*�
, <9�'&'(�-�=�-�='�
.����	���9@�� 
C. ���=�>.->*�
, <9�'&'(�-�=�-�9��������>������	 Check box ��� Position block when 

inserting 
D. �����	 Check box 9����+��
��		(9�)> Block ='�
.����	���9@�� 
E. ���=�>.���*�@�
 Block 
�&�*+�B
 (Row) &'(&�*��� (Column) 	*���B
���=�>	(0(=��

@�
&�*��B
<�
 (Column &'( Row Spacing) 

F. �')�9?������9@�� Block 
G. 9'���9����+��
��		(�-.->*�
@�
 Block ���?�B����@�
 Drawing ������	���9@�� 

 
 ��	<	��
 Block ��� Block 9>)�  
 9	�<���	,���=�>
=�*�+,-������0����B
=�>
� Drawing 
=�9:;� Block �>���B
=�> ��	<	��
 Block ���9:;�
����9>�0*������ Block ���9�0<	��
@KB���&'�* 9	�<���	,���=�>
=�������� Block 9>)��>� 
��	<	��
 Block ��� Block 9>)� 
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1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Tools > Create Block. 
� 9'������ Toolbar ���	�:   
� ?)�?D  block  &'�*�> Enter 

2. ?)�?D���� Block ���+��
��	 &'�*�> Enter 
3. 
� prompt box .(,��,K
��	<	��
 Block ���@�
9>)�=	����� 9'����:���  Yes - Redefined 

Block 
4. 	(�-+��&=��
*�
@�
+�* Block 
5. 9'���*�+,-���+��
��	���9:;� Block  &'�*�> Enter 
 

�
����������: 
��	N����+��
9	�0�*�+,-���=�0�:9����
.����	��� Block <���	,9	�0�������>�G>0?)�?D Undelete 
=	�� Oops &'�*�> Enter  
 
 ��		(9�)> Block 
 9	�<���	,�����		(9�)> Block 
�&�	� Block G>0 Block ���,��	(9�)>.(�'��</�?9:;��-N<���+)
9>)� 9����9	�<��
	(9�)> Block ���.(��H'�	(����� Block ���9	�<��
	(9�)>9�����B�&'(*�+,-.(�'����9:;��-N<���+)
9>)�9=��������-N<���+)�������.(�����	<	��
9:;� Block ='�
.�������		(9�)> Block &'�*+�* Block 9='����B�0�

<���	,�����	 Insert �>�9=����9>)� ,��9	�	(9�)> Block ����� Attribute ?�*
�0�� Attribute 9='����B�.(=�0�: 
&+� Attribute 9>)�@�
*�+,-.(0�
�
�0�� 
��		(9�)> Block .(���
=� Block ���,��	(9�)>��B��'���:9:;�*�+,-&'(�'��<��</�?9>)�@�
*�+,- �������9	�.(���9:;� 
Block +�*�0��
9���,��9	�<	��
 Block .��*�+,-���9:;� Polyline ����I.(�'����9:;�9<�� Polyline 9=����9>)� 
��		(9�)> Block 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Modify > Explode 
� 9'������ Toolbar ���	�:   
� ?)�?D explode &'�*�> Enter 

 2.  9'��� Block ���+��
��	.(�����		(9�)>  
 3.  &'�*�> Enter 
 
 

������� Attribute 
 
 Attribute 9:;�@���*����)>=�K�
���9	�<���	,����:�		.-9�I��*�	�*���� Block 9	�<���	,
�� 
Attribute 9:;�@����'���H��+)>���*�+,-9��� Part number &'( 	��� 9:;�+�� @����'���9:;� Attribute 9:;���B
@����'
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+�0+�*=	��9:'��0�&:'
&���@�>�>� 9����9	������	���9@�� Block ����� Attribute :	(����0��G:	&�	�.(���=�>��� 
Attribute 9>)������&'(9	�<���	,&���@��� Attribute �>�G>0��	<��
&���@+�* Attribute /�0='�
.����	���9@�� 
Block 
 ='�
.��9	����9@�� Block ����� Attribute 9	�<���	,>K
9��@����'���9:;� Attribute �����9�I��*�9:;�
�E'D&'(���@����'9='����B��:���9:;� Part List =	�� Bill of Material 	*���B
9	�<���	,>K
@����'���9:;�
=��09'@@�
 Block 
�&+�'(9*'�������9@����
� Drawing  
 9	�<���	,���=�>
=���� Attribute 
=�&<>
=	�����&<>
�� Drawing �I�>� ��� Attribute ������&<>


=�9=I��� Drawing �I.(���&<>

���	 Plot '
���	(>�M>�*09���9>�0*��� &+�@����'@�
 Attribute 9='���I0�

+)>�0����� Block &'(<���	,>K
�����9�I�9:;��E'D�>�9=���������� Attribute ���&<>
�0���� Drawing  
 
 *)J���	<	��
 Attribute 
 9	�<���	,<	��
 Attribute G>0��	<	��
@���*�����9:;�@����'<��=	��+�* Attribute &'(='�
.����B��I
�����	�		�K�9@�����+�* Block 
���	<	��
 Attribute 9	�.(+��
���=�>���+��
A 
=����+�* Attribute UK�

:	(����:>�*0 Name, Prompt &'( Default value 	*�,K
�������A��B���� +��&=��
@�
@���*��, ��)>@�

+�*=��
<�� &'( Option mode (Hidden, Fixed, Validete &'( Predefined) 
@�B�+��*)J���	<	��
 Attribute 

1. ���+��@�B�+��+���:��B 
� 9'����:���9���  Tools > Defined Attributes 
� 9'������ Toolbar ���	�:   
� ?)�?D  ddattdef  &'�*�> Enter. 

2. ����>�('I�� Define Attribute ���=�>���@�
 Name, Prompt &'( Default Value  
3. 
�<�*�@�
  Insert Coordinates 	(�-+��&=��
@�
 Attribute =	���')����:-Q� Select 9'���
+��&=��
*�
@�
 Attribute 
� Drawing  

4. 
�<�*�@�
  Attribute Flags 9'������=�> Option mode  
5. 
�<�*�@�
  Text ���=�>'��MN(@�
+�*=��
<�� 
6. 9'������=�>��	<	��
 Attribute ���:-Q���B
<�
>�
+���:��B 

� �')����:-Q� Define 9����+��
��	<	��
 Attribute &'(�I�'����<���>�('I����B9=����9>)�9?������
��	<	��
 Attribute ����A ���+���: 

� �')���� Define Add Exit 9����+��
��	<	��
 Attribute &'(���.���>�('I����B=	��.�
���<��
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A. ?)�?D����@�
 Attribute 
B. 
<�@���*�����.(&<>

=�9	�:V�����@�
 Attribute 
�+�����9	����9@�� Block 
C. 
<����@�
 Attribute ������9	����=�>��B9	�.(<���	,���=�>
=���>�
�@�B�+��@�
��	���9@�� Block 
D. ���=�>+��&=��
*�
@�
@���*��G>0��	:V����� Coordinate 
E. �����	 Check box 9����+��
��	���
=�&<>
��� Attribute �� Drawing 
F. �����	 Check box 9����+��
��	���=�>���@�
 Attribute 
=�9:;����+�0+�*���<���	,&���@�>� 
G. �����	 Check box 9����+��
��	
=�G:	&�	�0��0�
��	
<����@�
 Attribute 
�@�B�+��@�
��	���9@�� 

Block 
H. �����	 Check box 9�������+��
��	
=�G:	&�	�&<>
 Prompt 
<����+�����9@�� Block &+�<���	,
&���@���@�
 Attribute �>�/�0='�
 

I. �')�9����+��
��	<	��
 Attribute &'(+��
��	�'����<���>�('I����B����	�B
 
J. �')�9����+��
��	<	��
 Attribute &'(+��
��	���.���>�('I����B 
K. �')�9����+��
��	���=�> Rotation @�
@���*�� 
L. �')�9����+��
��	���=�>�*��<�
@�
@���*�� 
M. ���=�>'��MN(��	*��
@�
@���*�� 
N. ���=�> Text style @�
@���*�� 
O. �')�9����+��
��	���=�>+��&=��
*�
@�
@���*��G>0��	�:���=�>���?�B����@�
 Drawing    
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 ��	&���@���@�
 Attribute 
 9	�<���	,&���@���@�
 Attribute �������9	�.(�����	&��+)>�:���+�* Block &'(�������.(���9:;� 
 Block  
 *)J���	&���@���@�
 Attribute  

1. ���+��@�B�+��+���:��B 
� 9'����:���9���  Modify > Edit Text 
� 9'������ Toolbar ���	�:   
� ?)�?D ddedit &'�*�> Enter 

2. 9'��� Text Attribute ���+��
��	&���@ 
3. &���@ Attribute name, Prompt string, Default value &'( ����A 
4. �')� OK. 

 

 
A. ���
<��=	��&���@ ����@�
 Attribute 
B. ���
<��=	��&���@ ���,��=���.� @�
 Attribute 
C. ���
<��=	��&���@���:�+)@�
 Attribute 
D. ���
<��=	��&���@+��&=��
*�
@�
+�* Attribute 
E. <�*�@�
��	&���@'��MN(@�
+�*=��
<�� 
F. <�*�@�
��	&���@&'(���=�> Option mode @�
 Attribute 
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 ��	&�� Attribute 
=�+)>�:��� Block 
 9	�<���	,&�� Attribute 
=�+)>�:��� Blocks ='�
.�����9	����=�> Attribute 9:;����9	�0�	��0&'(
����'�0*�+,-9>�0*������+�* Block 9����9	�9'���*�+,-���.(���9:;� Block &'(+�* Attribute 	�*�9@��>�*0��� 
='�
.�����	*� Attribute 9@����� Block G:	&�	�.(,��9	���B
�	�B
9����9	������	���9@�� Block &'(9	�<���	,
���=�>��� Attribute 
=������	�B
9����9	������	���9@�� Block 
�&+�'(�	�B
 
 
 ��	&���@��� Attribute ���&��+)>�0����� Block 
 9	�<���	,&���@��� Attribute ='�
.�����9	����9@�� Block ����� Attribute &���0�� 
 *)J���	&���@��� Attribute ���&��+)>�0����� Block 

1. ���+��@�B�+��+���:��B 
� 9'����:���9���  Tools > Edit Block Attributes 
� 9'������ Toolbar ���	�:    
�  ?)�?D ddatte &'�*�> Enter 

2. 9'��� Block ���+��
��	&���@ 
�>�('I�� Edit Block Attribute �I.(:	��W@KB�?	���&<>
 Attribute ��B
=�>������0��
� 
Block ��B�&'(
=�9	�9'���&���@ Attribute ���9	�+��
��	&���@  

3. &���@��� Attribute ���+��
��	 
4. �')� OK 

 

 
A. ���� Block ����		.- Attribute 9='����B��0�� 
B. <�*�@�
��	&<>
	�0����@�
 Attribute ��B
=�>����		.-�0��
� Block ��B 
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C. ���
<��=	��9'��� Attribute ���+��
��	&���@ 
D. ���
<��=	��&���@���@�
 Attribute 
E. �')�+�'
0��	����	&���@ 
F. <�*�@�
��	&<>
���@�
 Attribute ��B
=�>����		.-�0��
� Block ��B 
G. <�*�@�
��	&<>
@�
 Prompt@�
 Attribute ��B
����		.-�0��
� Block ��B 

 
 ��	>K
@����'@�
 Attribute �����9:;� Text file 
 9	�<���	,>K
@����'@�
 Attribute ���&��+)>�0����� Block ����K�9�I��*�9:;� Text File 9?���
��9:;�
@����'<��=	������:
��:	(G0��D����A 9	�<���	,����K�9�I��*�9:;� Format +��
A �>�>�
+���:��B 

� Comma Delimited Format (CDF) .(�		.-@����'
� 1 �		��>+�� 1 Block &'(
�&+�'( 
Field @�
 Attribute .(@�B�>�*09�	���
=��0  “ , “ (Comma) &'(
�&+�'( Field @����'.(:F>
>�*09�	���
=��0 “ ‘ “ (Single Quotation mark) 9	�.(+��
	(�- Template file 
���	>K

@����'@�
 Attribute ����:9:;��E'D CDF 

� Space Delimited format (SDF) .(�		.-@����'
� 1 �		��>+�� 1 Block &'(
�&+�'( 
Field @�
 Attribute .(,��EF�>�*0�*���*��
 Field .(�����9�	���
=��0&<>
��	&��

�&+�'( 
Field =	�����+�*��B���B�9�
9	�.(+��
	(�- Template file 
���	>K
@����'@�
 Attribute ����:
9:;��E'D SDF 

� Drawing Exchange Format (DXF) 9:;���	<	��
 Subset @�
 Standard DXF File 
(a*.dxf file) .(�����	����K�@����'@�
 Block ��B
=�>���*��.(9:;� Insertion Point, 
Rotation angle, &'(@����'@�
 Attribute ��B
=�>&'(���.��9:;�+��
���=�> Template File   

 �������.(>K
@����'@�
 Attribute ����:9:;��E'D Format @�
 CDF =	�� SDF 9	�.(+��
<	��
 
Template file ���9:;� ASCII text File ���9:;�+�*���=�> Field @�
@����'@�
 Attribute ���.(����K�'
9:;�
�E'D Format @�
 CDF =	�� SDF 
�&+�'(�		��>@�
 Template file .(9:;�+�*���=�>
�&+�'( Field @�

@����'@�
 Attribute G:	&�	� CAD�� ® <���	,	��	�
 Field �>�,K
 15 Field ����		.-@����'9��� Block 
name, x-, y- &'( z- Coordinate @�
.-> Insert point, Layer @�
 Drawing +����������	���9@�� 
Block &'( ����A 9	�<���	,���=�> Field +��
A 9='����B 
� Template file &'(+��
:	(����:>�*0����@�
 
Attribute ������*��0�*������ 
 
�&+�'(&,*@�
 Template file .(+��
9	)��+��>�*0 Field name ���� Block &'(.-> Insertion-
Point ���9='����B.(+��
@KB�+��>�*0 BL: &'(='�
.�����
*��
.(+��
@KB�+��>�*0+�*���M	 C (9:;���	:	(��Y
=� 
Field ��B�9:;� Field +�*=��
<��) =	�� N (9:;���	:	(��Y
=� Field ��B�9:;� Field +�*9'@) ='�
.����B�.(
:	(����:>�*0+�*9'@<��+�*9:;���	����*���*��
@�
 Field &'(='�
.����B��I.(��+�*���<��+�*9:;���	���,K
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.���*�.->�Y�)0� (
�<�*�@�
������9:;�+�*9'@) ,��
� Field ��B�9:;� Field @�
+�*=��
<�� +�*9'@<��+�*='�


.(+��
9:;�+�*9'@ 000  
 '��MN(@�
 Template file .(��'��MN(=���+��'��0A ���+�*+�*�0��
>�����B 
 
 

 
 

A. Field name 
B. Block name .(+��
@KB�+��>�*0 BL: 
C. .-> Insertion-Point .(+��
@KB�+��>�*0 BL: 
D. ����@�
 Attribute ���&���0����� Block ���+��
��	.(>K
��������@����' 
E. .���*�.->�Y�)0����+��
��	
��	N����9:;����+�*9'@ =	�� ,��9:;�@���*��+�*=��
<��.(9:;�+�*9'@ 000 
F. 9:;� Field ���=�>�*���*��
@�
@���*��=	��.���*�+�*9'@ 
G. ,��@KB�+��>�*0+�* C .(9:;���	���*�� Field ��B�.(9:;� Field @�
+�*=��
<�� &'( ,��@KB�+��>�*0+�* 

N .(9:;���	���*�� Field ��B�.(9:;� Field @�
+�*9'@ 
 
 ��	<	��
 Template file 

1. ��	<	��
 Template file <���	,<	��
�>�G>0��	
��G:	&�	�.��?*� ASCII text editor >�
9��� 
Microsoft Notepad, Microsoft WordPad &'(G:	&�	� word – processing 9��� 
Microsoft Word 9:;�+��  

2. <	��
 Field +��
A ���.��9:;�
��
� Template file   
3. ����K� Template file 
=�9:;� ASCII text format 

  
 *)J���	>K
@����'@�
 Attribute �����9:;� Text file 

1. ���+��@�B�+��+���:��B 
� 9'����:���9���  Tools  > Extract Attribute 
� 9'������ Toolbar ���	�:   
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� ?)�?D ddattext  &'�*�> Enter 
2. �')����:-Q� Select   &'�*9'��� Block ���9	�+��
��	>K
@����'@�
 Attribute 9<	I.&'�*�> Enter 
3. 	(�-��)>@�
�E'D Format ���.(>K
@����'��� 
4.  <��=	����	>K
@����'����:9:;��E'D CDF  &'( SDF  
=�	(�- Template file    
5. 	(�-�����E'D9:;�+�*����K�@����' 
6. �')�:-Q� Extract 

 

 
A. �')�9?���9'��� Block ���9	�+��
��	>K
@����'@�
 Attribute  
B. 9'�����)>@�
�E'D Format ���.(>K
@����'��� 
C. ���
<��=	��	(�- Template file   <��=	����	>K
@����'����:9:;��E'D CDF &'( SDF   
D.  	(�-�����E'D9:;�+�*����K�@����' 
E. �')�9?���+�'
>K
@����'��� 
F. �')�9?���	(�-�����E'D9:;�+�*����K�@����' 
G. �')�9?���	(�- Template file   <��=	����	>K
@����'����:9:;��E'D CDF &'( SDF 
H. ���
&<>
.���*� Block ���,��9'��� 

 
 ��	���
�)
/�?*�+,-.��/�0��� (External references) 
 9	�<���	,9����� Drawing ����9@����0�
 Drawing ���9:F>�0��G>0��	
��EP
��� External reference UK�

.(���9=���������	���9@�� Block UK�
*�+,-���9	����9@����0�
 Drawing ���9:F>�0��G>0
��EP
��� External 



��������	
��
�� CAD��  

reference UK�
EP
�����B.(��+�*�
���,K
<,����������� Drawing .��/�0���9@���� UK�
*�+,-������9@��.(&<>

=�9=I�
�� Drawing &+�*�+,-9='����B�.(���	*�9:;�*�+,-9>�0*������*�+,-@�
 Drawing ���9:F>�0�� >�*09=+-��B@��>�*��.-
@�
�E'D@�
 Drawing ���9:F>�0��.(���9?)��@KB�&'(0�
�
��@��>9���9>)� 
External reference .('��MN(H'�	(�����9=���������	���9@�� Block 9����9	����9@�� Block *�+,-������9@��.(
�'�09:;�*�+,-@�
 Drawing ���9:F>�0��&'(9��������	9:'��0�&:'
=	��&���@+�* Drawing >��
9>)� (Original 
Drawing) ���.(��� Update ���+�**�+,-������9@����0�
 Drawing ���9:F>�0�� &+�,��9	����9@��&�� External 
reference 9��������	9:'��0�&:'
=	��&���@+�* Drawing >��
9>)� (Original Drawing) +�* Drawing ���
���9@�����.(9:'��0�&:'
+���:>�*0 UK�
���.(9:'��0�&:'
G>0��+G���+)9����9	������	9:F> Drawing ��B
=��=	��,��
9	��	��*��+�* Original Drawing ����	&���@&'(9	�+��

=���� Update 9	��I<���	,<��
 Reload +�* 
Drawing ���9:;� External reference  
�@N(���9	�9:F> Drawing ��B�0�� 
��	
��EP
��� External reference .(��:	(G0��D���<��=	����	���/�?:	(��� (Assembly Drawing) 
�� 
External reference ���9@��G>0��	
��.-> Coordinate 9:;�+�*���
�)

���	���9@�� ��	���9@��&�� External 
reference .(��*0'>@��>�E'D@�
 Drawing &'(���
=�9	����
.*�� Drawing ����	 Update �-��	�B
�������	
&���@'��<-> 
 
 ��	���9@�� Drawing &�� Attach external reference 
 ��	���9@��*�+,-&�����	*�*�+,-������9@�����*�+,-����0��
� Drawing ���9:F>�0��.(9:;���	���9@��&�� 
External reference UK�
*�+,-������9@����.(9:;�*�+,-9���9>��0*��� Block &+�*�+,-������9@������B���.(9:;�*�+,-��� 
Link 9@���� ,��9	�&���@ Drawing ��� Link 9@����9	�<���	,<��
 Reload 9?������.(
=���� Update +�* 
Drawing ������9@���� 
9����9	����9@�� Drawing &�� External reference �-N<���+)@�
 Drawing ������9@��.(���9@����>�*09��� 
Layer, Linetype, Text style &'(�-N<���+)����A &+�.(&<>
/�?�	�EEF�@�
 Drawing ������9@���0��
9>�0* 
9	�<���	,���9@�� Drawing �>����9������9	�+��
��	&'(&+�'( Drawing ������9@��<���	,���*��&+�+��
������*��
.(9:;� +��&=��
���
�)
 (Position), Scale &'( Rotation angle 
  
 *)J���	���9@�� Drawing &�� Attach external reference 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Tools  > External Reference 
� 9'������ Toolbar ���	�:   
� ?)�?D xref  &'�*�> Enter 

2. &'�*9'���EP
���9:;� Attach  
3. 9'���  Drawing File ���.(���9@�� .����B��')��:���:-Q� Open 
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4. 	(�-+��&=��
 Insert �� Drawing ���9:F>�0�� 
5. 	(�- Scale factor ���9:;� x, y, =	�� z &'( Rotation angle =	��9'��� Done 9?������.(0��	��
��� Default 

 
 ��	0�9')���	���9@�� Drawing &�� External reference 
 ��	0�9')�*�+,-������9@����&<>
�� Drawing ���9:F>�0�� 9	�.(+��

��EP
��� Detach ��	0�9')���	���9@��
.(�����H'�	(�����?*� Properties ����0��
� Drawing ���9:F>�0��9��� Layer &'( Linetype  
*)J���	0�9')���	���9@�� Drawing &�� External reference 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Tools  > External Reference  
� 9'������ Toolbar ���	�:   
� ?)�?D xref  &'�*�> Enter 

        2.   &'�*9'���EP
���9:;� Detach  
3.   ?)�?D���� Drawing ���9	�+��
��	0�9')� &'�*�> Enter        

 
 ��		�G='>��	���9@�� Drawing &�� External reference 
 ,��9	���	&���@ Drawing ���9	����9@�� ��0�
 Drawing ���9	�9:F>�0��
�	�:&��@�
��	���9@��&�� 
External reference 9	�<���	,���.(<��

=�G:	&�	� Update ��	&<>
@�
 Drawing ������9@��
=�9:;�@����'
9>�0*��������	&���@'��<-> 
*)J���		�G='>��	���9@�� Drawing &�� External reference 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Tools  > External Reference 
� 9'������ Toolbar ���	�:   
� ?)�?D xref  &'�*�> Enter 

2. &'�*9'���EP
���9:;� Reload  
3. ?)�?D���� Drawing ���9	�+��
��		�G='> &'�*�> Enter        

 
NOTE: %��&����'������ Update ��
 Drawing �
�"���!����%$����%"������#�������+$ Drawing �
��
���
"���!��&�'��� ��)	�
�������	 Print ��#� Plot 
 
 ��	���9@�� Drawing &�� Overlay external reference 
 9���� Drawing ���9	����9@����B�����	���9@�� Drawing �������9:;���	���9@��&�� External reference ���
9:;�&�� Attach external reference =	�� Overlay external reference ���.(&�� Drawing 9='����B�
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��>�*0 &+� Drawing ������9@��&�� Overlay external reference ���.(���&<>
/�?�	�EEF�
=�9	�9=I� 9	�.(

��EP
��� Overlay 9����9	�+��
��	>�9R?�(����@�
 Drawing ������9@��G>0���9	����+��
��	>�/�?�	�EEF�@�
 
Drawing ������9@�� 9='����B� 
  
 *)J���	���9@�� Drawing &�� Overlay external reference 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Tools  > External Reference 
� 9'������ Toolbar ���	�:   
� ?)�?D xref  &'�*�> Enter 

2. &'�*9'���EP
���9:;� Overlay 
3. 9'���  Drawing File ���.(���9@�� .����B��')��:���:-Q� Open 
4. 	(�-+��&=��
 Insert �� Drawing ���9:F>�0�� 
5. 	(�- Scale factor ���9:;� x, y, =	�� z &'( Rotation angle =	��9'��� Done 9?������.(0��	��
��� Default 

  
 ��	9:'��0� Path @�
 Drawing ���9:;�+�* External reference  
 ,�� Drawing ���9:;�+�* External reference ����	9:'��0�<,�������	.�>9�I� (9:'��0� Directory) 
=	�� 9:'��0����� G:	&�	�.(&<>
@���*��*�����<���	,���9@�� Drawing �>�&'(.(���&<>
/�?�	�EEF�������9@�� 
9	�<���	,�����	9:'��0�<,�����.�>9�I�=	������@�
 Drawing ������9@���>�
=�� 
*)J���	9:'��0� Path @�
 Drawing ���9:;�+�* External reference 
 1.  ���+��@�B�+��+���:��B 

� 9'����:���9��� Tools  > External Reference 
� 9'������ Toolbar ���	�:   
� ?)�?D xref  &'�*�> Enter 

2. &'�*9'���EP
���9:;� Path 
3. 9@���:9'���  Drawing File �������	9:'��0�<,�����.�>9�I�=	��9:'��0����� .����B��')��:���:-Q� Open 

 
 ��	9:'��0���	���9@��&�� External reference 9:;���	���9@��&�� Block 
�	�:&��@�
��	 Insert 
&'( Bind 
 ��	���9@�� Drawing &�� External reference +�*�	�EEF�������9@��.(���
��*�+,-9>�0*������*�+,-����0��
�� Drawing ���9:F>�0�� UK�
���9:;���	 Link 9?����	�EEF���&<>
9�����B� ,����� Drawing �������	���9@�� 
Drawing &�� External reference �:9:F>���9�	���
���?)*9+�	D���� 9	�.(+��
9�� Drawing file ��B
=�>���
9:;� External reference �:>�*0&'(9	�.(+��
���=�> Path =	�� Directory 
=�9=�������9�	���
���?)*9+�	D
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���9	���� Drawing ��B���9:F> =	�����9	��I.(+��

��EP
��� Path 9?������.(9:'��0�<,�����.�>9�I�=	�� Directory 
@�
 External reference 9='����B� 
 EP
��� Insert 
����<��
 External Reference UK�
9:;�EP
���<��=	��9:'��0�.����	 Link 9?������.(&<>

&���	�EEF���9:;���	���9@���	�EEF�9='��9@����
�	�:&��@�
 Block UK�
���.(<(>*��*��
��	N����9	�9�� 
Drawing �������	���9@�� Drawing &�� External reference �:9:F>���9�	���
���� 
*)J���	9:'��0���	���9@��&�� External reference 9:;���	���9@��&�� Block 
�	�:&��@�
��	 Insert 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Tools  > External Reference 
� 9'������ Toolbar ���	�:   
� ?)�?D xref  &'�*�> Enter 

2. &'�*9'���EP
���9:;� Insert 
3. ?)�?D����@�
 Drawing ������9@��&�� External reference ���9	�+��
��	���9@����9:;� Block &'�*
�> Enter 

 
 ��	��� Drawing �������	���9@�� Drawing &�� External reference �:9:F>���9�	���
����.(�����*)J�
=�K�
�������>�9=�������EP
��� Insert ��B��I���EP
��
 Bind UK�
9:;�EP
���<��=	��9:'��0�.����	 Link 9?������.(&<>

&���	�EEF���9:;���	���9@���	�EEF�9='��9@����
�	�:&��@�
 Block 9=�������   
*)J���	9:'��0���	���9@��&�� External reference 9:;���	���9@��&�� Block 
�	�:&��@�
��	 Bind 

1. ���+��@�B�+��+���:��B 
� 9'����:���9��� Tools  > External Reference 
� 9'������ Toolbar ���	�:   
� ?)�?D xref  &'�*�> Enter 

2. &'�*9'���EP
���9:;� Bind   
3.   ?)�?D����@�
 Drawing ������9@��&�� External reference ���9	�+��
��	���9@����9:;� Block &'�*
�> Enter 

 
 
Xref Clipping 
 
 ='�
.��9	����9@�� Drawing &�� External reference 9	�<���	,���=�>@��9@+��	&<>

=���� 
Drawing 9='����B�G>0
�����<��
 Xclip 
���	���=�>@��9@+��	&<>
@�
 Drawing ���9:;� External 
reference 9	�<���	,���=�>��	&<>
9?�0
<�*����9	�+��
��	
=�&<>
&'(U���<�*����9	����+��
��	
=�&<>
G>0
���=�>
=�����0�����@��9@+ 
���	
�����<��
 Xclip 9	�.(
��EP
����>���'(	�0��	&'(9	�<���	,���.(���=�>
=�
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�	�EEF�&<>
&��
�@��9@+���9	����=�>=	��0�9')���	&<>
�I�>� UK�
���.(�����H'�	(�����*�+,-=	���	�EEF����
9:;� External reference 9?	�(���.(9:'��0�&:'
&����	&<>
@�
+�*�	�EEF�9�����B�   
9	�<���	,
�����<��
 Xclip �����	<	��
+�*@��9@+=	���	����	&<>
, '�@��9@+��	&<>
=	��<	��
9:;��	��
9<�� Polyline ���+�*@��9@+@�
��	&<>
&'(9	�<���	,:F>-9:F>��	&<>
��B
�	�EEF�&'(+�*�	�� 9����9	������	
:F> (Turn off) 9����9	�:F> (Turn off) +�*�	��.(���&<>
 &+��	�EEF����&<>
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 ��	���=�>+�*�	����	��� Xref Clipping 9:;�&��<��9='��0� (Rectangle)  

1. ?)�?D Xclip &'�*�> Enter 
2. 9'����:0�
*�+,-���9:;� External reference &'(/=	�� block ���9	�+��
��	��� Xref Clipping 
3. 9����9'���9<	I.&'�*�> Enter  
4. ?)�?D N &'�*�> Enter 9?���<��
<	��
+�*�	��=	���> Enter 9?���0��	����� Default ���9:;� New 

boundary  
5. ?)�?D R &'�*�> Enter 9?���9'�����	<	��
+�*�	��9:;�&��<��9='��0� (Rectangle) 
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1. ?)�?D Xclip &'�*�> Enter 
2. 9'����:0�
*�+,-���9:;� External reference &'(/=	�� block ���9	�+��
��	��� Xref Clipping 
3. 9����9'���9<	I.&'�*�> Enter  
4. ?)�?D N &'�*�> Enter 9?���<��
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